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ELMPI1AB 
El MPLAB es un software que 

junto con un emulado~ y un programa­
dor de los múltiples que existen en el 
mercado, forman un conjunto de herra­
mientas de desarrollo' muy completo 
para el trabajo y/o el diseño con los mi­
crocontroladores PIC desarrollados y 
fabricados por la empresa Arizona Mi-

. crochip Technology (AMT). 
El MPLAB incorpora todas las 

utilidades necesarias para la realización 
de cualquier proyecto y, para los que no 
dispongan de un emulador, el programa 
permite editar el archivo fuente en len­
guaje ensamblador de nuestro proyecto, 
además de ensamblarlo y simularlo en 
pantalla, pudiendo ejecutarlo posterior­
mente en modo paso a paso y ver como 
evolucionarían de forma real tanto sus 
registros internos, la memoria RAM y/o 
EEPROM de usuario como la memoria 
de programa, según se fueran ejecutan­
do las instrucciones. Además el entorno 
que se utiliza es el mismo que si se es­
tuviera utilizando un emulador. 

En las ¡siguientes líneas se pre­
tende ayudar a todos aquellos que se 
enfrentan por primera vez a este pro­
grama, tanto en su instalación como en 
la utilización de esta potente herra­
mienta que nos proporciona Arizona 
Microchip Tecnology. En el CD-ROM 
.que se adjunta con este curso se en­
cuentran las versiones · 4.12.00 y la 
4.99.07 del programa; ~stas versiones y 
las nuevas que van saliendo cada poco 
tiempo y que incorporan nuevos tipos 
de microcontroladores, se pueden obte­
ner de forma gratuita en la página web 
www .mJcrochip.com, el la cual se encuen­
tra una amplia información sobre todos 
los dispositivos que fabrica Al'viT. 

De~ las dos versiones, nosotros 
vamos a centramos en la V.l2.00, por 

ser esta la que menos recursos de soft­
ware ·y harware necesita para trabajar 
con ella, además está pensada para tra­
bajar con las herramientas de desarrollo 
MPLAB-ICD y el PICSTART que se 
encuentras ya muy difundidas, mientras 
que la versión V.99.07 está pensada 
para trabajar con el MPLAB-ICE 2000 
soportado en NT, esta versión presenta 
algunas modificaciones en las ventanas 
de configuración del programa respecto 
a la anterior, además para su correcto 
funcionamiento es necesario disponer 
de la g~ma alta de los sistemas operati­
vos qw¡ se mdican en el siguiente apar­
tado además del hardware más potente. 

INSTA'LACIÓN DEL PROGRAMA 
Los requerimientos mínimos para la 
instalación de los programas son: 
• Procesador 386,486 o Pentium' 
• Windows 3.1/95/98, Windows NT 

3.51/4.0, Windows 2000 ,MACOS 
7.0, o Unix compatible OS 

• 16 MB de memoria RAM para sis­
tema con Windows 95. 

• 24MB de RAM para Windows NT 
systems. 

• 32 MB para sistemas con W indows 
2000. 

• Unidad de CD-ROM. 
• Navegador (3.0 HTML) 
Se recomienda por AMT: 
• Procesador Pentium 
• 32 MB de memoria RAM 

El CD-ROM de Microchip requiere 
para su navegación de un programa 
HTML. Para los equipos con Windows 
95/98/NT se recomienda utilizar Inter­
net Explorer versión 5.0 o el Netscape 
Navigator versión 4.0, además hará falta 
para la lectura de los numerosos docu­
mentos en formato pdf el programa 
Adobe Acrobat Reader versión 3.0 o 
4.0. 

Estos programas pueden obtenerse 
gratuitamente en las correspondientes 
web: 
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Microsoft Internet Explorer 
www .microsoft.comm 

Netscape 
www.netscape.com 

Adobe Acrobar 
www.adobc.com 

Navigator: 

Reader: 

Winzip: http://www.pkware.com o en 
http://www.winzip.cofi\ 

Al introducir el CD;ROM en la uni­
dad correspondiente en, los sistemas que 
tengan instalado Windows 95/98, 
Windows 20000 o NT ,y que tenga ha­
bilitada la opción autorun, aparece en 
pantalla el mensaje de la Figura 1, acti­
varemos el botón de Y es. 

Figura 1.- Mensaje al arrancar el CD-ROM 

-
En caso de que no aparezca este men-
saje al arrancar el CD-ROM, buscar con 
el explorador de W indows el archivo 
\indextxt.htm para el formato de texto 
o el \index.htm para el formato gráfico, 
al ejecutar este archivo aparecerá una 
pantalla como la que se muestra en la 
Figura 2, que es similar a la tiene Mi­
crochip en su página web. 

Figura 2.- Pantalla de presentación del CD-ROM y de la pagina web de Mlcrochlp 
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Seguidamente, activamos el botón de 
Development Too/s, seleccionamos en 
la siguiente pantalla la opción MPLAB­
IDE y al final de la página a la que rios 
lleva este vinculo, encontramos el en 
lace MPLAB Version :4.12.00 que nos 
lleva a la página de descarga del pro­
grama MPLAB (Disks 1 to 7) (o los 7 
discos individualmente) y que descarga­
remos sobre un directorio de nuestro 
disco duro que por e)emplo habremos 
llamado C:\KK. Hemos seguido estos 
pasos ya que son los mismos que debe­
remos seguir para descargar las nuevas 
versiones desde la web de Microchip, 
pero de una forma más directa, podría­
mos haber copiado directamente sobre 
el directorio C:\KK los archivos que 
están en el CD-ROM en el directorio 
\download\Tools\PICmicro\DevEnv\M 
PLABi\Software\v412. Estos archivos 
están comprimidos con las utilidades 
WinZIP. Deberán descomprimirse di­
chos archivos utilizando las herramien­
tas WinZIP. 

. ' 

·- ... -~ ·~-M' ,..,. .. -~." 
'"""""-­·-Q-­--­... -~ ... 
~-l!·~ .. ••...a ..... "'),r.,. 
llf<ll ....., • ... ~~ ... ... '".~ ... --- _ ..... .. --loo , ....... .. 

Figura 3 .. Archivos en C:\KK\ obtenidos 
del CD y una vez descomprimidos con las 
utilidades WinZIP. Ejecutar MP412000.exe 

Una vez que finalicemos la ins­
talación de 1 programa podremos borrar 
por completo el subdirectorio C:\KK 
para dejar espaCio e.n 'el disco duro. Para 
instalar el programa se ejecuta el archi­
vo mp41200.exe, cuando esto ocurre 
aparece la pantalla de la Figura 4. 

Figura '4.- Pantalla de bienvenida a la insta­
lación del MPLAB. 

Activamos el botón de Next y el 
programa responde con una nueva pan­
talla como la que se muestra en la Figu­
ra 5, con el menú de todos los módulos 
del instalar. 

Figura 5.- No es necesario instalar todos los .,. 
módulos del programa. 

En principio, si no se dispone de 
emulador, podemos ahorrar espacio en 
el disco duro y no instalar estos módu­
los, para ello, se desactivan dichos cam­
pos tal y como se muestra en la Figura 
5, se activa el botón de Next, para pasar 
a la siguiente pantalla. Igualmente pul­
samos el botón de Next en la pantalla de 
Select Language Components en donde 
dejaremos activos todos los campos. 
Aparece la pantalla de la Figura 6 en la 
que se debe seleccionar el directorio 
donde queremos que se instale el pro­
grama, por defecto lo hace en el directo­
rio C:\Archivos de programas\MPLAB. 
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Figura 6.- Selección del subdirectorio donde 
se instalará el programa MPLAB 

Una vez finalizada la instalación 
que puede tardar unos minutos, se pue­
de pasar a ejecutar el programa 
MPLAB, es recomendable que si se va a 
utilizar mucho este programa, lo cual 
esperamos, se haga un acceso directo a 
dicho programa con lo que tendremos 
en el escritorio de Windows un icono 
como el de la 

Figura 7.- Icono de acceso directo al pro­
grama MPLAB 

Antes de seguir adelante, recomen­
damos crear una carpeta con el explotador 
de Windows por ejemplo C:\Archivos de 
programas\MPLAB\Trabajo, dentro de la 
cual posteriormente iremos creando todos 
nuestro proyectos. 

COMO EMPEZAR. 
Cuando se pulsa el icono del 

MPLAB aparece una pantalla como la 
que se muestra en la Figura 8. 

Lo primero que haremos es se­
leccionar el modo de trabajo como si­
mulador y el tipo de microcontrolador 
con el que queremos trabajar. Para ello 
se selecciona el botón de Options de la 
barra del control que aparece en el es­
critorio y del menú desplegable la op­
ción Deve/opement Mode, con lo que 
aparece la pantalla de la Figura 9 en la 
que se activa el modo MPLAB-SIM si­
mu/ator y el microcontrolador con el 
que se desea trabajar, que en nuestro 
caso será el PICI6F84, por último, pul­
samos el botón de Reset para aceptar los 

Figura 9.- Selección de la opción de trabajo 
como simulador y el tipo de microcontrola­
dor 

Los iconos que aparecen en la 
barra de herramientas, son funciones 
que se encuentran incluidas en el menú 
de control, pero como en todos los pro­
gramas de W indows se incluyen para 
manejar de forma más cómoda el pro­
grama. Seguidamente comentaremos 
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que significa cada uno de los iconos de 
la barra de herramientas que aparece en 
esta pantalla, mas adel'\flte veremos que 

Barra de 
herramientas 

Conmutador de la 
Barra de herramientas 

~uevo documento 

Cerrar fichero 

Salvar archivo en dJ.sco 

Cortar 

Copiar 

Pegar 

hay más barras de herramientas que 
pueden ser conmutadas 

Numero de 

líneas 

Mover el cursor a 
la línea n° 

Tabulador a la 
LZqUlerda 

Tabulador a la derecha 

Inummir 
Buscar cadena de texto . 

Deshacer 

Buscar cadena de texto 
repetidas veces 

Buscar y cambiar reptidamente 

Buscar y cambiar 

Figura 10.- Barra de herramientas de edición 

NUESTRO PRIMER PROYECTO 
Bueno, pues ya estamos en con­

diciones de crear nuestro primer pro­
yecto, para ello comenzamos por activar 
en el menú de control la opción Fi­
le>New o bien activamos el icono de 
crear nuevo documento en la barra de 
herramientas. El programa contestará 
con el cuadro de diálogo de la Figura 
11. 

Figura 11.- No hay ningún proyecto abierto 
¿Quiere crear un nuevo proyecto? 
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Activamos el"bofóri'de; Ye.fy aparece un 
cuadro de dialogo como el de la Figura 
12 en el que se nos pide el nombre del 
proyecto que tendrá :extensión *.pjt , 
como este es nuestro primer proyecto le 
llamaremos ejerl.pjt y lo guardaremos 
en la carpeta de trabajo que habíamos 
creado anteriormente. ' 

Figura 12.- Creación de un nuevo proyecto 

El programa devuelve el cuadro de diá­
logo de la Figura 13 

Figura 13.- Propiedades de edición del pro­
yecto 

Activamos el botón de OK y estamos en 
condiciones de empezar a escribir nuestro. 
primer proyecto al aparecer una pantalla 
como la de la Figura 14 

Figura: 14.- Apertura del documento para 
comentar a escribir nuestro proyecto 

EL EDITOR 
Comencemos por lo tanto a escribir 

en len'guaje ensamblador nuestro primer 
prognima que llamaremos ejerl.asm y 
que se muestra en la Figura '15. El pro­
grama realiza la suma en binario de dos 
números (7+8 = 15) y para escribirlo 
usamos el editor de textos. La extensión 
*.asm es la que deben llevar todos los 
programas escritos en ensamblador. 

Deberemos de tener en cuenta que la 
primera columna del editor está reserva­
da para las etiquetas que son expresio­
nes alfanuméricas escogidas por el usua­
rio que definen valores de posiciones de 
memoria. Estas deben empezar siempre 
por una letra. Además se debe de tener 
en cuenta que no pueden usarse expre­
siones que ya utiliza el ensamblador 
tales como: 

• Instrucciones 
• Directivas del propio ensambla­

dor 
• Nombres de registros especiales 

(SFR) 
• Nombre de cada uno de los bit de 

los registros especiales. 
En las siguientes columnas, se puede 

comenzar a escribir el nemónico de la 
instrucción o las directivas del ensam­
blador. Por último hay que decir que se 
pueden y se deben añadir comentarios 
que son elementos indispensables en 
muchos casos para seguir el razona­
miento de los programas sin perderse, 
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para ello cuando el MPLAB encuentra 
un ";"(punto y coma) no se genera códi­
go máquina. 

En todos estos ca~pos los espacios 
en blanco no son sigruficativos y las 
líneas en blanco tampoco. 

Para una mejor legibilidad del pro­
grama, se recomienda; acceder a cada 
campo utilizando el tab~lador. 

El uso de mayúsculas y minúsculas 
' en los programas obedece a una serie de 

reglas o. normas de estÜo, comunes entre 
los programadores en ensamblador, que 
si bien no son obligatorias, facilitan la 

lectura del código fuente. Estas reglas 
son: 

• Las directivas del ensamblador se 
escriben en mayúsculas 

• Los nombres de las variables se escriben 
en mayúsculas. 

• Los nemónicos de las instrucciones se 
escriben en minúsculas 

• El programa se escribe utilizando los 
tabuladores para definir las distintas 
'columnas, tales como etiquetas, comien­
. zo de líneas de programa y columna 
:donde empiezan los comentarios separa­
'dos por un";" (punto y coma). 

Fecha : 1 - Marzo - 2000 Programa Ej~r1.ASM 
Este progra~a suma dos 

(; en la posición 0M10 
Revisión : 0.0 
Uelocidad del Reloj: 

valores inmediatos (en este caso 7+8) el resultado se deposita 

1: Perro Guardian : 
~~ Protección del código 

4 HHz 
deshabilitado 
: OFF 

Programa para PIC16C84 y PIC16F84 
Reloj Instrucción: 1 MHz • 1 us 
Tipo de Reloj : XT 

,;************************************************************************************** 
! 

LIST ~·1ÓF84 ;Tipo de procesador 

lADO EQU Ox10 ;Define la posición del resultado 

ORG oxoo ;Uector de Reset 
gato INICIO 

ORG Ox05 ;Salua el uector de interrupción 

moulw 0K07 ;carga 1er. suroando en w 
addlw 0K08 ;Suroa el 29 suroando 
roouwf RESULTADO ;Al~acena el resultado 

sleep 
1 

;Poner ponerse a dormir 

END ;Fin del programa fuente 

Figura 15.- Nuestro primer programa ejerl.asm 
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Cuando terminemos de escribir 
el programa seleccionamos File>Save 
con lo que aparece el cuadro de diálogo 
de la Figura 16, donde le damos el 
nombre a nuestro programa ejerl.asm , 

nuestra Trabajo. 

Figura 16.- Salvar el programa ejerl.asm en 
la carpeta de trabajo 

El siguiente paso será volver a editar 
nuestro proyecto seleccionando en el 
menú de control projecf>edit project , 
lo que provoca que aparezca el menú de 
la 17. 

Figura 17.- Pantalla de edición del proyecto 

Púlsamos sobre ejerl[.hex], y se activa el 
botón de Node Properties, que hasta el 
momento aparecía de color gris, si lo 
activamos aparece el cuadro de diálogo de 
la Figura 19,donde están reflejadas todas 
las propiedades del nodo actual. Sin 
modificar ninguna de estas propiedades se 
pulsa el botón de OK para continuar, lo 
que nos lleva de nuevo a la pantalla de la 
Figura ;1 7. Ahora seleccionamos el botón 
Add Node (añadir elementos al nodo), lo 
que provoca que aparezca un nuevo 
cuadro\ de diálogo como el de la Figura 
18, en iel que seleccionaremos el archivo 
ejerl.asm 

Figura 18.- Nombre del archivo a incluir en 
el proyecto ejerl.asm 
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Figura 19.· Propiedades del nodo de nuestro proyecto donde se seleccionan los ficheros y formatos 
que se obtendrán al ensamblar el programa. ~ 

Pulsamos el botón de Aceptar y 
se vuelve a la pantalla de "la Figura 17 en 
la que ha aparecido el fichero 
ejerl[.asmj junto al fichero ejerl[.hexj 
que aparecía antes en el campo de 
Project files. Seguidamente pulsamos el 
botón de OK, lo que· nos llevará de 
vuelta a la pantalla de la Figura 15. Para 
ensamblar el programa seleccionamos en 
el menú de control la opc10n 
Project>Build All (también podríamos 
haber pulsado el botón correspondiente 
de la barra de herramientas del simula-

d l~l 1 ) . or , como uego veremos , y st no 
se han cometido errores al introducir los 
códigos, aparece una pantalla como la de 
la Figura 20, lo que nos indica que el 
programa se ha ensamblado con .éxito y 
ya estamos en condicio11es de iniciar la 
simulación del programa. Si por el con­
trario, se han detectado errores, en dicha 
pantalla será mostrado el error; si se hace 
doble clic sobre la línea que muestra el 
error, el cursor saltará directamente a la 
línea de código donde se encuentra el 
error. Una vez subsanados los. errores 
habrá que V()lver a compilar el programa. 

Figura 20.- Pantalla del MPLAB una vez 
ensamblado correctamente el programa fuen­
te 

LA BARRA DE MENÚS 
Seguidamente analizaremos las 

distintas posibilidades de la barra de 
menú del MPLAB, si bien ya hemos 
utilizado algunas de las posibles opcio­
nes que presenta la barra de herramien­
tas, ahora analizaremos estas una por 
una. 
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1.- Windows: 
Al activar esta opción de la barra de me­

el menú desplegable de la 
' 

Figura 21.- Menú desplegado de la opción 
Windows de la barra de herramientas. 

1.1.- Program Memory : Al seleccionar 
esta opción aparece la pantalla de la Fi­
gura 22 en la que se puede apreciar las 
posiciones de memoria que ocupa cada 
una de las instrucciones, el código de 
operación de cada mstrucción y la posi­
ción de memoria que se le ha dado a 
cada etiqueta. 

Figura 22 .- Pantalla de la ventana de Memo­
ria de programa. 

Si hacemos clic sobre la barra de menú 
del sistema, activando el icono que hay 
en la parte superior izquierda de esta 
ventana, aparece el menú desplegable de 
la Figura 23, en el que se puede selec­
cionar entre tres formas de ver la memo­
ria de programa: 

Figura 23.- Despliegue de opciones del menú 
de sistema. 

• Hex Code Display: representa la 
memoria de programa con los datos 
en hexadecimal. Esta opción es muy 
útil al usar el programador del dispo­
sitivo y comprobar si se grabaron 
bien los datos. La pantalla que se 
obtiene es la que se muestra en la Fi­
gura 24. 
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3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 
3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 
3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 
3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 
3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 
3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 
3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 
3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 
3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 
3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 
3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 
3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 
3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 
3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 
3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 
3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 
3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 
3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 
3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 
3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 
3FFF SFFF 3FFF 3FFF 3FFF 3FFF 3FFF 
3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 
3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 3FFF 

Figura 24.- Memoria de programa en código 
hexadecimal. 

• 

• 

Machine Code Dispaly: esta opción 
presenta el código máquina ensam­
blado tal y como se ve en la Figura 
22. Con la información de las eti­
quetas y . direcciones de memoria 
que tienen asignadas. 
Disassembly Display: despliega el 
código hexadecimal desensamblado 
con los símbolos. 
Cuando la ventana está en la opción 

Machine Code o Disassembly Display, 
la instrucción a la que apunta el conta­
dor de programa, está resaltada. 

1.2.- Trace Memory : La ventana de 
memoria de traza toma "una instantá­
nea" de la ejecución del programa, 

cuando este está corriendo en tiempo 
real. 

Para emuladores que tienen un 
buffer de traza, que se utiliza cuando el 
programa corre en tiempo real y este no 
se puede detener en algunas aplicacio­
nes, nos muestra los puntos por los que 
pasa el ·programa. Algunos problemas 
sólo aparecer cuando la aplicación está 
corriendo, es decir, estos no dan la cara 
cuando se ejecuta en modo paso a paso. 
La memoria de traza es una herramienta 
de depuración para probar tales aplica­
ciones. Para más información es reco­
mendable mirar en la guía de usuario del 
emuladór que se esté utilizando. En el 
simuladór, el buffer de traza o memoria 
de traza,1 es útil para visualizar un regis­
tro a lo largo de la ejecución del progra­
ma, de manera, que se puede registrar 
por donde pasa el programa y después 
analizarlo. El simulador toma datos de 
forma un poco distinta que el buffer del 
emulador. 

Antes de activar la opción Trace 
Memory, para poder obtener los datos en 
la memoria de traza en el simulador, es 
necesario marcar con el ratón las líneas 
de código de programa de las cuales que­
remos obtener los datos al ejecutarse el 
programa, estas pueden estar en un blo­
que de instrucciones o bien colocadas en 
el programa de forma discontinua. Se­
guidamente, se pulsa el botón de la de­
recha del ratón, de manera que aparece 
el menú desplegable de la Figura 25. 
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LIST 

EQU 

ORG 

p•16F84 

ox10 

OxOO 
ntn IHH!II1 

ORG oxos 

;Tipo de procesador 

;Define la!posición del ... esultado 

;Salua el uector de interrupción 

Figura 25.- Selección de las líneas de programa para cargar el buffer de traza. 

Al seleccionar la opción Trace Point(s) 
aparecen resaltadas las líneas en color 
verde. Seguidamente se activa el icono 

del semáforo verde liiJ (Run), lo que 
hará ejecutar la simulación en "tiempo 
real"( no olvidemos que en el simulador 
emula el funcionamiento del microcon­
trolador y es mucho más lento que este), 
y después de unos segundos, si activa-

rrlOIJWf 

sleep 

mos el icono del semáforo rojo lil1 
Halt the processor, se detiene la ejecu­
ción del programa. Si ahora se activa 
dentro de la opción Windos>Trace Me­
mory, se pueden ver la traza obtenida, 
que en nuestro caso en la que se muestra 
en la Figura 26. 

134667 
269336.00us 134668 
26933B.OOus 134669 
269340.00us 134670 

Figura 26.- Traza de memoria obt~nida en el programa con los valores ma~cados en la Figura 25 

El simulador muestra· en esta 
ventana el valor del tiempo que tarda en 
ejecutar cada línea de programa y tam­
bién cualquier variación sobre los regis­
tros al ejecutarse el código de instruc­
ción. 

1.3.- EEPROM Memory: Si el dispositi­
vo emulado iiene EEPROM o memoria 

Flash, como es el caso del PICI6C84 o 
·· el 16F84 respectivamente, el contenido 

de la memoria EEPROM puede verse 
seleccionando la. opción 
Window>EEPROM. 
La memoria de EEPROM no puede mo­
dificarse a .través .de esta ventana. Para 
ello hay que utilizar el menú de dialogo 
al que se accede selecionando 
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Window>ModiJY ... , que se describe más 
adelante. 

1.4.- Absolute Listing: La Ventana de 
"Listado de Programa", realmente nos 
presenta el archivo de riuestro proyecto 
con extensión *.lst, donde se puede ver 

el archivo generado por el ensamblador 
o compilador. El listado muestra el códi­
go fuente en modo absoluto con el códi­
go objeto generado, tal y como se puede 
ver en la Figura 27. 

02.30 Rebased EJER1.ASM 2-20-2000 10:28:18 PAGE 1 

OBJECT CODE 
UALUE 

LIHE SOURCE TEXT 

00001 
00002 
00003 
DODOJJ 
00005 
00006 
00007 
00008 
00009 
00010 
00011 
00012 
00013 
00014 
00015 
00016 
00017 
00018 
00019 
00020 

; ............................................................... .. 
Programa Ejer1.ASM Fecha : 1 - Mat"ZO 
Este progra111a su~a dos ualores inmediatos (en este caso 7+8) el 
en la posición DK10 
Reuisión O. O 
Uelocidad del Reloj: 4 MHz 

Programa para PIC1 
Reloj Instrucción: 

Perro Guardian deshabilitado Tipo de Reloj : Xl 
Protección del código : OFF 

; ............................................................... .. 

00000010 RESUlTADO 

LIST 

EQU 

DRG 
goto 

ORG 

p-16F84 

0X10 

oxoo 
UfiCIO 

oxos 

;Tipo de procesador 

;Define la posición del re · 'r ;, 

;Uector de Reset 

;Salua el uector de intert 

IHICIO moulu Ox 07 ;Carga 1er. sumando en W 

Figura 27.- Archivo ejerl.lst 

Además al final de este archivo 
aparece la información de las etiquetas 
utilizadas en el programa, en que línea 
de programa se encuentran, la memoria 
utilizada, la memoria libre además de los 
errores, warnings y mensajes reportados 
por el ensamblador. 

1.5.- Stack: El contenido de la pila pue­
de verse al seleccionar la opción 
Window>Stack. 

Los contenido de la pila puede 
mostrarse con o sin número de línea. El 
formato de presentación se selecciona a 
través del menú del sistema. Si la Pila se 
desborda, el MPLAB indica con su rebo­
samiento con el mensaje underflow. 

Al menú del sistema se accede 
pulsando el botón de la esquina de la 
ventana. 

Figura 28.- Ventana de la Pila 

1.6.- File Registers : La lista de registros 
de propósito general (GPR) del micro­
controlador, que son de memoria SRAM, 
se pueden ver seleccionando la opción 
Window>File. Esta ventana al desple­
garse presenta una lista con todos los 
registros de proposito general del dispo­
sitivo emulado, tal y como se muestra en 
la Figura 29. 
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su vez el movimiento giratorio de una­
leva o de un árbol unido al dispositivo de 
disparo. Si la corriente absorbida por el 
receptor supera el valor

1 
de reglaje del 

relé, las bilárninas se ¡ deformarán lo 
bastante corno para que la pieza a la que 
están unidas las partes móviles de los 
contactos se lit-ere del tope de sujeción. 
Este movimiento causa la· apertura brusca 
del contacto del relé intercalado en el 
circuito de la bobina del contactor y el 
cierre del contacto de señalización. El 
rearme no será posible hasta que se 
enfríen las bilárninas. Relés térmicos 
LR2-D de Telernecanique (1) La norma 
lEC 94 7-4 sustituye el concepto de "relé 
diferencial" por el de "relé sensible a una 
pérdida de fase". 

Compensación de la temperatura 
ambiente 
La curvatura que adoptan las bilárninas 
no sólo se debe al calentamiento que 
provoca la corriente que circula en las 
fases, sino tam~ién a los cambios de la 
temperatura ambiente. Este factor 
ambiental se corrige con una bilámina 
de compensación sensible únicamente a 
los cambios de la temperatura ambiente y 
que está montada en oposición a las 
bilárninas principales. Cuando no hay 
corriente, la curvatura de las biláminas se 
debe a la temperatura ambiente. Esta 
curvatura se corrige con la de la bilárnina 
de compensación, de forma tal que los 
cambios de la temperatura ambiente no 
afecten a la posición del tope de sujeción. 
Por lo tanto, la curvatura causada por la 
corriente es la única que puede mover el 
tope provocando el disparo. 
Los relés térmicos compensados son 
insensibles a los cambios de la 
temperatura ambiente, normalmente 
comprendidos entre -40 oc y + 60 oc. 

Reglaje 
Los relés se regulan con un pulsador que 
modifica el recorrido angular que efectúa 
el extremo de la bilámina de 
compensación para liberarse del 
dispositivo de sujeción que mantiene el 
relé en posición armada. La rueda 
graduada en amperios permite regular el 
relé con mucha precisión. La corriente 
límite de disparo está comprendida entre 
1,05 y 1,20 veces el valor indicado. 

Detección de una pérdida de fase 
Este dispositivo provoca el disparo del 
relé en caso de ausencia de corriente en 
una fase (funcionamiento monofásico). 
Lo componen dos regletas que se mueven 
solidariamente con las bilárninas. La 
bilárnina correspondiente a la fase no 
alimentada no se deforma y bloquea el 
movimiento de una de las dos regletas, 
provocando el disparo. 
Los receptores alimentados en corriente 
monofásica o continua se pueden proteger 
instalando en serie dos bilárninas 
que permiten utilizar relés sensibles a una 
pérdida de fase. Para este tipo de 
aplicaciones, también existen relés no 
sensibles a una pérdida de fase. 

Clases de disparo 
Los relés térmicos se utilizan para 
proteger los motores de las sobrecargas, 
pero durante la fase de arranque deben 
permitir que pase la sobrecarga temporal 
que provoca el pico de corriente, y 
activarse únicamente si dicho pico, es 
decir la duración del arranque, resulta 
excesivamente larga. La duración del 
arranque normal del motor es distinta 
para cada aplicación; puede ser de tan 
sólo unos segundos (arranque en vacío, 
bajo_ par resistente de la máquina 
arrastrada, etc.) o de varias decenas de 
segundos (máquina arrastrada con mucha 
inercia), por lo que es necesario contar 



dialogo de la opción Modify (Figura 40) 
en la que aparecerá ya la dirección del 
registro seleccionado. · 

1.8.- Show Symbol List : · 
Esta ventana muestra un listado de los 
símbolos, es decir variables y etiquetas, 
utilizadas en el código fuente del pro­
grama. 
Estos símbolos están en el archivo 
*.COD de nuestro proyecto. En la Figu­
ra 32 se muestra el listado de símbolos 

Figura 32.- Ventada del listado de símbolos 
utilizados en nuestro programa fuente. 

Programa Ejer1.ASM 
Este programa suma dos 
en la posición Ox10 
Revisión : 0.0 
Uelocidad del Reloj: 
Pe~ro Guardian : 
Protección del código 

LJST 

SULTADO EQU Ox10 

1.9.- Stopwatch and Clock Frecuency: 
Para calcular el tiempo de ejecución de 
nuestro programa o de una subrutina, 
podemos contar el número de instruccio­
nes que· se realizan y multiplicarlo por 4 
veces la frecuencia de la señal de reloj 
(tiempo de un ciclo máquina) o por 8 en 
el caso de que las instrucciones sean de 
salto. Esto en algunas ocasiones es engo­
rroso, pero el MPLAB con esta opción 
de cronómetro nos permite medir tiempo 
de ejecución de las instrucciones de 
nuestro programa sin equivocaciones. 
El cronómetro calcula el tiempo basán­
dose en la frecuencia del reloj del micro­
controlador PIC que estamos simulando, 
para ello previamente debemos fijar la 
frecuencia del oscilador empleado. Esto 
se realiza haciendo los siguientes pasos: 
Activamos desde el menú Opti­
ons>Processor Setup>Clock frequency 
tal y como se muestra en la Figura 33 

para PIC161 
Instrucción: 

de Reloj : XT 

;Define la posición del res• 

Figura 33.- Camino a seguir para definir la frecuencia del microcontrolador Options>Processor 
Setup>Clock frequency 

Inmediatamente se abre un cuadro de 
dialogo como la de la Figura 34, donde 
se fija la frecuencia del reloj. 
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Figura 34,. Definición de la frecuencia de 
oscilador del microcontrolador. 

Después se activa la opción 
Windows>StopWatch, con esto. conse­
guimos tener siempre abierta la ventana 
que muestra el tiempo transcurrido y los 
ciclos máquina empleados en la ejecu­
ción de cada instrucción, como puede 
verse en la Figura 35. 

;Salua 1 

;Carga · 
;Suma e: 
;Almace1 

', 

Figura 35.- Cronometro para contar el tiem­
po que tarda en ejecutarse un programa o 
parte de él. 

1.10.- Project Windows : La Ventana del 
Proyecto sólo está disponible cuando hay 
un proyecto abierto. Presenta la lista de 
archivos que actualmente hay en dicho 
proyecto. Si el proyecto se ha ensambla­
do o compilado la ventana del proyecto 
muestra una lista de todos los archivos 
incluidos en el proyecto. 

Por otra parte, la ventana del 
Proyecto sólo presenta el archivo del 
proyecto. principal. Un doble. clic en 
cualquier archivo resaltado en la ventana 

del proyecto, abrirá dicho archivo para 
su revisión. 

roject listing 
ath: 
roject Ha~~e: 
arget: 

Tool suite: 
rocessor: 
oeuelop~nt Hode: 

Target Data 
File List: 
ption String: 
uild Tool: 

C: \ARCH 1 U"'1\MPLAB\ TADAJO' 
EJER1.PJT 
EJER1.HEX 
Kicrochip 
PIC16F84 
Sh1Ulator 

EJER1.ASM; 
te•;tl•;tx-;tc•; 
HPASH 

EJER1.ASM 

Figura 36.- Ventana deProyecto 

1.11.- Watch Windows : 
MPLAB permite supervisar los conteni­
dos de los registros del archivo a través 
de una ventana temporal. Para abrir una 
ventana temporal, se selecciona 
Window>Watch Windows. El programa 
responde con un cuadro de diálogo como 
el de la Figura.37 

Figura 37.- Cuadro de diálogo de los simbolos 
de la ventana temporal 

Para agregar los registros a visualizar, 
poner el ratón encima de uno de ellos 
pulsar el botón de la izquierda, seguida­
mente activar el botón de Add. También 
se pueden anular los símbolos poniendo­
se sobre ellos y pulsando el botón iz­
quierdo del ratón y seguidamente el bo­
tón de Delete. Cuando estén todos los 
registros seleccionados pulsar el botón 
de Close y aparecerá una ventana, en 
este primer caso, Watch_l, como puede 
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verse en la Figura 38, en la que se ven 
los símbolos (etiquetas y variables) se­
leccionados 

ddress Syrobol Ualue 
18 RESULTADO H'OF' 
!200 w H'OF' 
l02 pcl H'OO' 
DA pclath H'OO' 

Figura 38.- Ventana Watch_l 

Para ver y cambiar las propieda­
des de un símbolo, hay que pulsar el 
botón de propiedades que aparece en el 
cuadro de diálogo de la Figura 37, al 
hacerlo aparece un de 

w•u".u corno el de la 

Figura 39.- Cuadro de diálogo de las propie­
dades de los datos de las ventanas temporales 

El contenido de la ventana del 
reloj puede desplegarse mostrando o sin 
mostrar los números de la línea. Para 
elegir el formato deseado se hace a tra­
vés del menú del sistema (pulsando el 
icono de la parte superior izquierda de la 
ventana).El menú del sistema también se 
usa para revisar la información en la 
ventana temporal. 

La ventana de diálogo permite 
seleccionar el formato en que el se pre­
sentan los símbolos: 
•Format.- Determina qué tipo de nume­
ración se desea visualizar. 
•Size.- Determina cuántos bytes serán 
incluidos en la visualización del número: 

hexadecimal, decimal, binario, ASCII o 
float. 
Byte Order.- Determina el orden de vi­
sualización de cada byte, disponible sólo 
para los números de 16 bits. 
•Display Bits.- Determina en qué mo­
mento se visualiza el bit seleccionado al 
activarse. 

1.12.- Modify: Al activar la opc10n 
Window>Modify .•. aparece el cuadro de 
diálogo Modify como el que se muestra 
en la Figura 40. En este cuadro se per­
mite leer y escribir una posición de me­
moria o el rango de una posición de 
memoria. Modify puede trabajar en las 
áreas de memoria siguientes: 
•Data 
•Stack 

Figura 40.- Cuadro de diálogo de la opción 
Modify 

Corno resumen a todo lo que he­
mos contado hasta el este momento, po­
demos decir que el comando Windows, 
puede presentar una visión de todos los 
registros del microcontrolador en cada 
momento y podemos tener al final una 
pantalla en la que visualicemos según 
nos interese las ventanas mas adecuadas 
para el seguimiento de nuestra aplica­
ción, corno puede ser la de la Figura 41. 
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MPLAB 

LIST 

EQU 

ORC 
goto 

ORC 

PIOUWf 

sleep 

EHD 

p=16F84 

ox10 

oxoo 
INICIO 

OX05 

RESULTADO 

00 
00 00 
00 00 
00 00 
00 00 00 

;Define la 255 
24 

;Uector de o 
o 

1F 31 
;Salua el 00 o 

FF 255 
00 o 
00 o 
00 o 
DO o 
00 o 
DO o 

;Fin del DO o 
02 2 

Figura _41.- Presentación de algunas ventanas de forma simultánea en pantalla 
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APENDICEB 

ENSAMBLADOR IASMU 

APENDICEB 
ENSAMBLADOR IASMI 1 

Para ensamblar un programa a ser ejecutado por el microcontrolador HC 11 en cualquier versión de 
este; se pueden recurre a dos maneras distintas: 

a) Editar el programa éñ lenguaje ensamblador, en el editor de texto de su preferencia y guardarlo en 
su disco de trabajo con extensión ASM o ASC. 

Una vez hecho lo anterior, desde el sistema operativo se pueden emplear los ensambladores 
ASMHCll, IASMll o ASll; con el siguiente formato: 

AS 11_ Nombre _programa.ASM/ ASC 

Si no existe ningím error, se genera el programa en lenguaje de máquina con extensión S 19 . 

.. 

b) Empleando el programa ensamblador lASMll 

Este programa contiene internamente la posibilidad de editar, ensamblar y poder realizar comunicación 
con el microcontrolador, tiene un ambiente accesible para su manejo; el despliegue que se presenta es 
muy similar a un editor de texto, como se muestra en la figura l. 

NOMANE.ASM Line 1 Coll Byte O Insert Indent 

Fl-Help F2-Save F3-Load F4-Assemble F5-Exit F7-Comm F9-DOS shell FlO-Menu 

Figura l. 

Las teclas de función se describen a continuación; 

Fl Pasa al sistema de ayuda. 

F2 Salvar el programa que se está editando actualmente. 

F3 Cargar un programa. 

F4 Ensamblar el programa actual . 

FS Salir del ensamblador. · 

F7 Cargar y ejecutar un programa previamente ensamblado. 

F9 Shell al sistema operativo. 

Laboratorio de Microcomputadoras 



APENDICEB 
ENSAMBLADOR IASMI 1 

FlO Pasar a otro sistema de comandos; los comandos que se obtendrán al seleccionar esta función. 
son Jos siguientes: · 

1 Edit File Assemble Communicate Help 

Edit Regresa al modo de edición 

File Manejo de archivos 

Assemble Se configura el formato del programa que se obtendrá al seleccionar la función de 
ensamblar; las posibles opciones con las que cuenta este comando son: 

Assemble F4 
Object off 

·Listing off 
DebugMap off 
Cycle cntr off 
Macros Hide 
Includes Hide 

Communicate Sirve para configurar los parámetros de comunicación, como son la velocidad de 
transmisión, la longitud de palabra, bits de inicio y de paridad. 

Help Comando para invocar la ayuda. 

Para invocar a loas diferentes comandos, se puede realizar tecleando la letra mayúscula que 
corresponde al comando o llegar a el con las flechas del cursor. 

Columna 
No.l 

~ 
ETIQUETA 

Formato de la instrucción: 

INSTRUCCIÓN OPERANDOS ;COMENTARIOS 

Es importante que las etiquetas inicien en la columna número uno y las instrucciones propias del 
ensamblador en cualquier posición. 

El procedimiento para ensamblar un programa es el siguiente: 

a) Se edita el programa; 

b) Con la tecla FlO, se pasa a otro sistema de comandos; 

Laboratorio de Microcompltladoras 
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e) Seleccionar el comando de ensamblar; · 

APENDICEB 
ENSAMBLADOR !ASMJ 1 

d) Configurar el formato del o de los programas que se requieran; en el Objeto seleccionar con 
ENTER el programa S19; 

e) Con la tecla ESC se sale de ese comando hasta regresar a la pantalla principal; 

f) Se presiona la tecla F4 para ensamblar el programa; 

g) Si no existió ningún error, se generan los programas seleccionados en el submenú de ensamblado. 

Con el programa S 19 se puede pasar a simular el funcionamiento del programa, en su caso, con la 
seguridad de su correcta operación, se puede bajar y ejecutar directamente en el microcontrolador. 

Laboratorio de Microcomputadoras 
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APENDICEC. 
SIMULADOR A VSIMll 

APENDICE Jl 
SIMULADORAVSJMJJ 

Con el programa A VSIMll se pueden simular los programas realizados para los microcontroladores 
de la familia 68HC11 en sus versiones A8, AO y A2, tanto en modo single chip como en modo 
expandido; se pueden simular con otras versiones del HC 11, pero considerando algunas restricciones, 
como son la cantidad de puertos que se tienen disponibles, así como las direcciones asignadas para 
ellos en el mapa de memoria del microcontrolador. 

El primer desplegado que presenta este programa, nos sirve para seleccionar la vers10n del 
microcontrolador, con el cuál se simulará un programa previamente editado y ensamblado; tal como se 
muestra en la figura l. 

AVSIMll Simulator/Debugger 

Serial #KA0613 7 Licensed by Avocet Systems, In c. 

Copyright (C) 1987,1988 by Ken Anderson Software 
Al! Rights Reserved · 

Microcomputer Configurations 

Single-Chip Mode 
A:68HC11A8 
B:68HC11AO (no EEPROM) 
C:68HC811A2 

Expanded Mode 
D:68HC11A8 + 68HC24 PRU 
E:68HC11AO + 68HC24 PRU 
F:68HC811A2 + 68HC24 PRU 

Choose a Configuration for simulation: 

Figura l. 

Una vez aceptada la opción del microcontrolador, se desplegará una pantalla similar a la que presenta 
en la figura 2, misma en la que se pueden identificar los siguientes elementos: 

a) En la parte izquierda (LABEL OPERATION), es donde se ubicará el código del programa a 
simular; es decir indicará la dirección asignada para cada instrucción y su mnemónico. 

b) En la parte superior se ubican los acumuladores A y B, indicados por la etiqueta CPU REGISTERS. 

e) A la derecha de la posición de los registros, se ubica el registro de banderas (FLAGS), identificando 
las banderas SHNZVIX; la bandera de acarreo © se encuentra del lado izquierdo de los 
acumuladores. 

d) A un costado derecho del registro de banderas se encuentran los indicadores del modo de 
simulación, como la velocidad y otros parámetros. 

Laboratorio de Microcomputadoras 
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APENDICE B 
SIMULADOR A VSIMI 1 

· e) Debajo de los acumuladores se encuentran el Stack Pointer (SP) y el Program Counter (PC), los 
cuales se irán modificando de acuerdo a Jos valores actuales, de igual forma se identifican los 
registros de Indice Y y X. 

f) Se dispone de dos ventanas para observar e introducir valores, indicados como Memory Space; es 
posible seleccionar cualesquiera de las ellas, así como la dirección donde se desea que inicie el 
desplegado. 

g) Del lado derecho en su parte media se encuentran los registros asociados a los puertos seriales (SCI 
y SPI). 

h) En la parte inferior derecha, se encuentran los puertos paralelos A,. B, C, D y E; lugar donde se 
podrá visualizar el valor actual que contienen estos puertos. 

LABEL OPERATION 68HCIIA8 AVSIMI1 Simulator/Debugger V1.50 
$0000 ERROR CPU REGISTERS FLAGS SCL SPD DSP SKP CURSOR 
$0001 ERROR C A:ACCUMULATOR SHNZV IX OFF HI ON OFF MENU 
$0002 ERROR O OOOOOOOO:OO:q 10000 11 PINS Cycles: 
$0003 ERROR B: 00000000:00: COP:OOOO IXAB SPI SPDR:OO: 
$0004 ERROR addr data RTI:OOOO 1100 TDR:OO: 
$0005 ERROR PC:OOOO » 00 00 00 00 00 00 00 00 SPSR:OOOOOOOO· 
$0006 ERROR SP:OOOO » 00 00 00 00 00 00 00 00 SCI SCDR:OO: 
$0007 ERROR 00 00 00 00 00 00 00 00 TDR:OO:_ *00:_ 
$0008 ERROR X :0000 » 00 00 00 00 00 00 00 00 SCCR2:00000000 
$0009 ERROR Y :0000 » 00 00 00 00 00 00 00 00 SCSR:JIOOOOOO 
$000A ERROR TMR:OOOO 1:0000 0000 0000 M1 :00000000 M2:0000 F2:0000 
$000B ERROR PA:OO O:FFFF FFFF FFFF F1 :00000000 PORTS ddr 
$000C ERROR Memory Space A IOOOOIII 
$0000 ERROR 1000 00 00 03 00 00 00 00 00 00: :00000000 
$000E ERROR 1008 00 00 00 00 00 00 00 00 B : 00000000 
$000F ERROR 1010 00 00 00 00 00 00 FF FF 00: :00000000 
$00JOERROR 10!8FFFFFFFFFFFFFFFF C IIIIIIII 
$0011 ERROR Memory Space 00: :00000000 
$0012 ERROR 1020 00 00 00 00 00 00 00 00 D 1 1 1 1 11 
$0013 ERROR 1028 04 00 00 00 00 00 CO 00 00: : 000000 
$0014 ERROR 1030 00 00 00 00 00 00 00 00 E I I 1 1 I 1 1 1 
$0015 ERROR 1038 00 10 00 00 05 01 00 OF 00: :00000000 

>Select Command - or use arrow keys 
Dump Expression commandFile Help 10 Load --space-- ESC to screen 

Figura 2. 
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El total de comandos con los cuales se puede trabajar son los siguientes 

Dump 
Memory 

Expression 
Patch Quit 

commandFile 
Reset 

Help 
Set 

lo 
View 

APENDICE B 
SIMULADOR AVSIMJ 1 

Load 
eXecute 

Cada uno de estos comandos contienen generalmente otro sistema de subcomandos; existen dos formas 
de accesar a ellos, con la letra mayúscula asociada al comando o con las flechas del cursor seguido de 
la tecla enter. 

El procedimiento para simular un programa es el siguiente. 

Una vez con el programa ensamblado se ingresa al simulador seleccionando la versión del 
microcontrolador a su elección. 

l. Cargar el programa 

Loads- Program Enter filename: Nombre_programa.S19 

Introducir el nombre de su programa, es necesario indicar 
la extensión. 

El programa se visualizará a partir de la dirección de inicio, esta dirección se indica en el contador de 
programa PC. 

2. Selección de la ventana para visualizar y en su caso introducir los datos 

Dump Area: 1 2 (1 la ventana superior, 2 ventana inferior) 
seleccionar en el siguiente comando Absolute 
Enter Expression in Memory Address S pace: $Direc_Inicio 
Se indica a la dirección donde se comenzará a verse la ventana. 

3. Configuración de la ventana seleccionada para que trabaje como memoria RAM 

Set Memory-map r amdom_Access 
Enter Expression in Memory Address Space: $Direc_Inicio 
Enter Expression in Memory Address Space: $Direc_Final 

En esta parte se indica la dirección inicial y la final para configurar el rango de memoria RAM. 

4. Ejecución de la simulación 

Fl Ejecución del programa en forma continua 
Fl O Ejecución de una sola instrucción 
F9 Ejecución por pasos hacia atrás --

5. Salir del simulador 
Quit Exit 

El simulador cuenta con un sistema de ayuda, para invocar se selecciona el comando Help. 

Laboratorio de Microcomputadoras 
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•. Apendice A 
MICROCONTROLADOR MC68HCJJE9/Fl 

APENDICEA 
MICROCONTROLADOR MC68HC11 

Se consideran para el curso la posible utilización de las versiones de esta familia conocidas como 
E9 y Fl, por lo que en el caso de existir alguna diferencia se mencionarán en su oprtunidad. 

Características generales MC68HC1IE9 

El MC681-IC11E9 es un semiconductor de alta densidad de óxido de metal complementario 
(1-ICMOS), unidad microcontroladora (MCU). Esta MCU tiene un voltaje de operación bajo, de alta 
velocidad, con un bus multiplexado de una velocidad nominal de 2MHZ. 

Las características especiales de este microcontrolador son: 

• Cinco puertos paralelos, con doble función cada uno de ellos (A,B,C,D,E) 
• Expansión de sistemas de tiempo, con cuatro etapas preescalables 
+ Se resalta el no retorno a cero (NRZ) 
+ Interface de Comunicación Serial (SCI) 
• Convertidor Analógico Digital de ocho canales, con ocho bits de resolución 
+ Bloque protector de mecanismo para EEPROM y CONFIG 
+ Bus multiplexado 
+ Empaquetado de 58 pines 
+ Tope para el ahotTO de energía y modos de espera 
• 64 Kbytes de memoria direccionable 
+ Interface de Comunicación con Periféricos (SPI) 
+ 512 Bytes de EEPROM 
+ 512 Bytes de RAM 
+ 12 Kbytes de ROM, con el Buffalo programado 
• Circuito de Interrupción real 
+ Acumulador de pulsos 
+ Captura de entrada 
+ Comparación de salida 

Características generales MCGSHCllFI 

+ 512 Bytes de EEPROM 
+ 1024 Bytes de RAM interna 
+ Sistema temporizador 

• Tres funciones de captura de entrada (IC) 
• Cuatro funciones de comparación de salida (OC) 
• Cuarta o quinta función de IC y OC respectivamente, seleccionada por software 

• Función de chip selects 
+ Circuito de interrupción en tiempo real 
• Acumulador de pulsos de ocho bits 
• Interfaz serial con periféricos (SPI) 
• Interfaz de comunicación serial (SCI) 
• Convertidor Analógico Digital 

• Ocho canales 
• Ocho bitas de resolución 

Laboratorio de Microcon(putadoras 
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Figure 1-1. M68HC11 E-Series Block Diagram 
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t Bus de datos y direcciones no multiplexado 

• Encapsulado PLee de 68 pines 

Apendice A 
MICROCONTROLADOR MC68HC 11 E9/F1 

t Siete puertos paralelos con doble función cada uno de ellos (A, B, e, D, E, F, G) 

Modos de operación de HCll 

Emplea dos pines, para seleccionar el modo de operación, el MODA y el MODB, básicamente 
existen dos modos de operación normales, que son el single chip y el expandido, y dos modos de 
operación especiales, el bootstrap y el test, La selección del modo de operación es de acuerdo a los 
valores codificados en estos pines. 

Single Chip 

Solo se dispone de la memoria interna del microcontrolador. Los puertos B y e, así como las 
terminales STRA y STRB están disponibles como entrada y salida paralelas de propósito general; 
todo el software necesario para controlar el Me U está contenido en los recursos internos. 

Expandido 

En el modo de operación expandido, permite accesar a la memoria externa dentro de la totalidad de t 
los 64 Kbytes de espacio direccionable, el espacio incluye al espacio de memoria interna del modo, 
single chip, los puertos B" y e se emplean para realizar la expansión de memoria, el puerto B 
formará la parte alta del bus de direcciones y el puerto e tendrá la función multiplexada para la 
parte baja del bus de direcciOnes y el bus de datos, además incluye las señales AS, E y R/W. 

Test 

Permite el acceso privilegiado a recursos internos del MeU, este es una variacwn del modo 
expandido y es normalmente empleado para pruebas internas de producción por el fabricante. 

Bootstrap 

Es una variación especial del modo single chip, este pennite dar entrada a programas en la RAM 
interna. Al seleccionarse este modo de operación, durante el restablecimiento una pequeña ROM de 
boostrap se hace presente en el mapa de memoria. Esta contiene un pequeño programa el cuál 
inicializa la interface serial asíncrona de comunicación (Sel), lo cuál permite al usuario cargar 
programas dentro de la RAM interna, finalizando esto, el control lo tendrá el programa recién 
cargado. Este es el modo de operación en el cual se trabaja con mayor frecuencia. 
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Modelo del Programador 

Apendice A 
MICROCONTROLADOR MC68HC 11 E9/F 1 

La familia del MC68I-IC 11 tiene ocho registros de unidades centrales de proceso, disponibles para 
el programador. Cada registro es explicado en los siguientes párrafos. 

Acumuladores (A, By D) 

Los acwnuladores A y B son registros de 8 bits, de propósito general, utilizados para almacenar los 
operandos y los resultados de las operaciones lógicas o aritméticas o para la manipulación de 
infonnación. 

Estos dos acumuladores concatenados fonnan el doble acwnulador que será de 16 bits de longitud, 
donde el acwnulador B es la parte baja y el acwnulador A es la parte alta de este doble acwnulador. 

o 7 o 7 
Acumulador A Acumulador B 

15 o 
Acumulador D 

Registro de índice (IX) 

El registro IX es w1 registro de 16 bits, donde su utilidad se encuentra principalmente para el modo 
de direccionamiento indexado. Provee unos 16 valores que pueden ser sumados a un offset de ocho 
bits para accesar una dirección efectiva. Este registro puede ser también utilizado para realizar 
tiempos de retardo o como un área de almacenamiento temporal. 

15 o 
Registro de índice X (IX) 

Registro de índice Y (!Y) 

Es un registro de 16 bits, utilizado para el modo de direccionamiento indexado, similar al del 
registro IX. Sin embargo la mayoría de las instrucciones donde se empleá el registro !Y, tiene dos 
bytes y requiere un byte extra de código de máquina y un ciclo extra al momento de su ejecución. 

15 o 
Registro de índice Y (IY) 

Contador de programa (PC) 

El contador de programa PC es un registro de 16 bits, contiene la dirección de la siguiente 
instrucción que será ejecutada. 
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Apendice A 
MICROCONTROLADOR MC68HC JI E9/F 1 

Contador de programa (PC) 

Apuntador a la pila (SP) 

El stack pointer SP e·s im registro de 16 bits que contiene la dirección de la siguiente ubicación libre 
en el stack. El stack es configurado como una secuencia de últimos en entrar, primeros en salir 
(UFO), lec registros de escrirura que permiten datos importantes para ser almacenados durante 
interrupciones y llamados a subrutinas. · 

15 o 
Stack Pointer (SP) 

Registro de banderas (CCR) 

El registro de banderas es un registro de 8 bits, en el cuál cinco bits son utilizados para indicar los 
resultados de la instrucción recién ejecutada, dos bits mascarables de interrupciones y un bit de 
paro. Estas banderas pueden ser checadas individualmente por el programa y realizar una tarea 
especifica como resultado de su estado; cada bit se explica a continuación. 

7 6 5 4 3 2 o 
S X H I N z V e 

( C) Acarreo (Carry/Borrow) 

El bit C indica si en la úluma operación realizada, ya sea lógica o aritmética existió w1 acarreo, esta 
bandera actúa también como una bandera de error para las operaciones de multiplicación y división, 
asi mismo se afecta durante las operaciones de rotación de los registros. 

(V) Desbordamiento (Overflow) 

El bit V indica si ocurrió un sobreflujo como resu)tado de una operación. 

( Z ) Cero (Zero) 

Se fija cuando el resultado de la última operación lógica, aritmética o manipulación de datos es 
cero. 

(N) Negativo (Ncgativc) 

El bit N indica si el resultado de la última operación aritmética, lógica o manipulación de datos es 
negativo, es decir, refleja el estado del bit más significativo (MSB) de un resultado. Un número es 
positivo cuando el MSB es cero y es negativo cuando MSB es uno. 
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( H) Medio Acarreo (Halft Carry) 

Apendice A 
MICROCONTROLADOR MC68HC 11 E9/F 1 

Indica el acarreo existente en una operación aritmética entre los bits tercero y cuarto; es de utilidad 
cuando se desea hacer el ajuste a decimal del resultado de una suma. 

( I) Interrupción de Máscara 

Este bit puede ser activado por software y hardware para habilitar todas las fuentes de interrupción 
de máscara. , .~ 

(X ) Interrupción de Máscara 

El bit X se activa solamente por hardware (RESET o XIRQ) y limpiado solamente por el programa 
de instrucciones de transferencia de A hasta CCR o retomando de intetTupciones (RTI). 

(S) lnhabilitador de Paro 

Este bit permite habilitar o deshabilitar la instrucción de stop. 

Modos de Direccionamiento 

El MCU cuenta con seis modos de direccionamiento, inmediato, directo, extendido, indexado, 
inherente y relativo, que son utilizados para obtener o almacenar Wl dato, de o hacia alguna 
localidad de memoria. 

Modo de Direccionamiento Inmediato (INM) 

En el modo de direccionamiento inmediato, el argumento actual está contenido en el byte(s) que 
siguen a la instrucción. 

Ejemplo: 
Formato: Instrucción #Dato 

LDAA #$AO 
LDAB #%01100011 

; Carga el dato $AO en hexadecimal al acumulador A 
;Carga el dato binario indicado al acumulador B 

Modo de Direcciouamiento Directo (DIR) 

En el modo de direccionamiento directo, el byte menos significativo de la dirección efectiva de la 
instrucción aparecerá en el byte siguiente al opcode. El byte más significativo de la dirección 
efectiva es tomado como $00. Este modo de clireccionarniento hace referencia al espacio de 
memoria comprendido entre $0000 y $00FF, es conocido como direccionamiento página cero. 

Ejemplo: 
Formato: Instrucción $00Dirección 

LDAA #SAO 
STAA S50 

;Carga el dato indicado al acumulador A 
;Envia el contenido de A a la dirección $50 
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Apendice A 
MICROCONTROLADOR MC68HC JI E9/Fl 

Modo de Direccionamiento Extendido (EXT) 

La dirección efectiva de la instrucción aparece explícitamente en los dos bytes siguientes al opcode. 
Por lo tanto se puede hacer referencia al área total del microcontrolador es decir de la dirección 
$0000 a la $FFFF. 

Formato: Instrucción $Dirección 
Ejemplo: 

LDAA #$01FF ;Carga el dato indicado al acumulador A 
ST AA $1004 ;Envía el' contenido del acwnulador A en la dirección $1004 

Modo de Direccionamiento Indexado (INDX, INDY) 

Los registro de índice X o Y son empleados para hacer referencia a la dirección efectiva donde se 
obtendrá o almacenani el dato. La dirección efectiva es variable y depende del contenido actuál del 
registro de índice a emplear y de un OFFSET sin signo, contenido en la instrucción. 

Ejemplo: 
Formato: /Jtstrucción $0ffset,Reg_índice 

LDX #$1000 
LDAB $3l,X 

;Inicializa el registro de índice X 
;Carga el contenido de la dirección $1031 en B 

Modo de Direccionamiento Inherente (INH) 

En este modo de direccionamiento, toda la infonnación necesaria para ejecutar una instrucción, está 
contenida en el código de operación. 

Ejemplo: 
INX 
ABA 

Formato: Instrucción 

;Incrementa el contenido del registro X 
;Swna el contenido de los acumuladores A y B 

Modo de Direccionamiento Relativo (REL) 

Su utilidad se encuentra en los saltos o brincos relativos, comúnmente ejecutados después de una 
comparación o lectura del CCR; para lo cuál es posible la toma de decisiones de bifurcación. Las 
instrucciones de bifurcación generan dos bytes, uno para el opcode y el otro para el offset relativo. 
Si la condición de bifurcación es verdadera, el contenido de los 8 bits del byte siguiente al opcode 
(offset) son sun1ados al contenido del contador de programa para fonnar la dirección efectiva de la 
bifurcación, de otra manera, el control pasa a la instrucción siguiente a esta. 

Ejemplo: 
LDAA $!00A 
CMPA #$FO 
BEQ igual 
BNE diferente 

Formato: Instrucción Etiqueta 

;Carga en A el contenido de la dirección $100A 
;Compara A con el dato #$FO 
;Si Z=l brinca a igual 
;Si no es igual brinca a diferente 
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Figure 4-4. Memory Map for MC68HC(7)11 E9 
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.. Apendice A 
MICROCONTROUDOR MC68HC 11 E9/F 1 

Puertos Paralelos 

En lo que se refiere al sistema de puertos paralelo existen diferencias sustanciables entre las 
diferentes versiones del HC 11, en el caso concreto de las versiones E9 se cuentan con cinco puertos 
paralelos y en la versión Fl se disponen de siete puertos paralelos, cuyas características se describen 
a continuación. 

Puertos Paralelos Microcontrolador MC68HC11E9 

En la serie E del microcontrolador MC68HC11, se disponen de 5 puertos paralelos, y un total de 38 
pines de entrada y salida; a continuación se presentas estos: 

Puerto A 

Pines 
Bidireccionales 

2 

8 

6 

Al puerto A no le afecta el modo de operacwn, viene configurado para esta versión del 
microcontrolador de la siguiente manera, tres pines de salida, tres de entrada y dos que se pueden · 
seleccionar como entrada o salida. ' 

PORTA Datos de Puerto A $1000 

Bit 7 Bit 6 Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit O 
PA7 PA6 PA5 PA4 PA3 PA2 PAl PAO 

PAI OC2 OC3 OC4 1C4/0C5 ICI IC2 IC3 

Puerto B 

En single chip y bootstrap todos los pines del puerto B son salidas de propósito general; en el modo 
expandido y test, fonnan la parte alta del bus de direcciones. 

PORTE Datos del Puerto B $1004 

Bit 7 Bit 6 Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit O 
PB7 PB6 PB5 PB4 PB3 PB2 PBl PBO 

ADR15 ADR14 ADR13 ADR12 ADR!l ADRIO ADR9 ADR8 
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Puerto e 

Apendice A 
MICROCONTROLADOR MC68HCI 1 E9/F 1 

En single chip y bootstrap, el puerto e se puede configurar para que trabajen sus pines como salida 
o entrada, dependiendo de la selección realizada en el registro DDRe. En el modo expandido y test, 
el puerto e tiene la función multiplexada para la parte baja del bus de direcciones y el bus de datos. 

DDRe Registro de Dirección de Datos del Puerto e $1007 

Bit 7 Bit 6 Bit S Bit 4 Bit 3 Bit 2 Bit 1 Bit O 
DDe7 DDe6 DDes DDe4 DDe3 DDe2 DDel DDeO 

DDC(7:0) Dirección de datos para el puerto e 

O =Bit seleccionado como entrada 
1 =Bit seleccionado como salida 

PORTe Datos del puerto e $1003 

Bit 7 Bit 6 Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit O 

Pe7 Pe6 PeS Pe4 Pe3 Pe2 Pe! Pe o 

ADR7 ADR6 ADR5 ADR4 ADR3 ADR2 ADRI ADRO 
DATA7 DATA6 DATAS DATA4 DATA3 DATA2 DATA! DA TAO 

Puerto D 

Al puerto D o le afecta el modo de operación, pero únicamente se dispone de 6 bits de propósito 
general de entrada o salida, seleccionados por la configuración del registro DDRD; tiene su doble 
función con los subsistemas Se! y SPL 

DDRD Registro de Dirección de Datos del puerto D $1009 

Bit 7 Bit 6 Bit S Bit 4 Bit 3 Bit 2 Bit 1 Bit O 
DDDS DDD4 DDD3 DDD2 DDDI DDDO 

PORTD Datos del puerto D $1008 

Bit 7 Bit 6 Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit O 
PD5 PD4 PD3 PD2 PDI PDO 

PDS PD4 PD3 PD2 PDI PDO 
SS Se K MOSI !vil SO TxD RxD 

Puerto E 

El puerto E es de 8 bits de entrada general, no le afecta el modo de operación, comparte su función 
con el convertidor analógico digitaL 
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' Apendice A 
MICROCONTROLADOR MC68HCJ JE9/FJ 

PORTE Datos del Puerto E $100A 

Bit 7 Bit 6 Bit 5 Bit 4 Bit 3 Bit 2 Bit l Bit O 
PE7 PE6 PE5 PE4 PE3 PE2 PE! PEO 

AN7 AN6· AN5 AN4 AN3 AN2 ANl ANO 

Puertos Paralelos Microcontrolador MC68HC11Fl 

En la serie F! del microcontrolador MC68HCII, se disponen de 7 puertos paralelos, y un total de 54 
pines de entrada y salida; a continuación se presentas estos: 

Puerto A 

Pines 
Bidireccionales 

8 

8 
6 

8 

Al puerto A no le afecta el modo de operación, se configura en sus ocho bits como se desea trabaje, 
este puerto. 

PORTA Datos de Puerto A 

Bit 7 Bit 6 Bit 5 Bit 4 
PA7 PA6 PA5 PA4 

PAl OC2 OC3 OC4 

DORA Registro de Datos del Puerto A 

Bit 7 Bit 6 Bit 5 Bit 4 
DDA7 DDA6 DDA5 DDA4 

DDA(7:0) Dirección de datos para el puetto C 

O= Bit seleccionado como entrada 
l = Bit sélcccionado como salida 

$1000 

Bit 3 Bit 2 Bit 1 Bit O 
PA3 PA2 PA1 PAO 

IC4/0C5 ICI IC2 IC3 

$1001 

Bit 3 Bit 2 Bit 1 Bit O 
DDA3 DDA2 ODA! DDAO 
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Puerto B 

Apendice A 
MICROCONTROLADOR MC68HCJJ E9/F 1 

En single chip y bootstrap todos los pirres del puerto B son salidas de propósito general; en el modo 
expandido y test, forman la parte alta del bus de direcciones. 

PORTE Datos del Puerto B $1004 

Bit 7 Bit 6 Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit O 

PB7 PB6 PB5 PB4 PB3 PB2 PBl PBO 

ADR15 ADR14 ADR13 ADR12 ADRll ADRJO ADR9 ADR8 

Puerto C 

En single chip y bootstrap, el puerto e se puede configurar para que trabajen sus pines como salida 
o entrada, dependiendo de la selección realizada en el registro DDRe. En el modo expandido y test, 
el puerto e realizará la función del bus de datos. 

DDRe Registro de Dirección de Datos del Puerto e $1007 

.. 
Bit 7 Bit 6 Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit O 

DDe7 DDe6 DDe5 DDe4 DDC3 DDe2 DDel DDeO 

DDC(7:0) Dirección de datos para el puerto e 

O =Bit seleccionado como entrada 
1 = Bit seleccionado como salida 

PORTC Datos del puerto e $1006 

Bit 7 Bit 6 Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit O 

Pe7 Pe6 Pe5 Pe4 PC3 Pe2 Pel Pe O 

ADR7 ADR6 ADR5 ADR4 ADR3 ADR2 ADRl ADRO 
DATA7 DATA6 DATAS DATA4 DATA3 DATA2 DA TAl DA TAO 

Puerto D 

Al puerto D o le afecta el modo de operación, pero únicamente se dispone de 6 bits de propósito 
general de entrada o salida, seleccionados por la configuración del registro DDRD; tiene su doble 
función con los subsistemas ser y SPI. 

DDRD Registro de Dirección de Datos del puerto D $1009 

Bit 7 Bit 6 Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit O 
DDD5 DDD4 DDD3 DDD2 DDDI DDDO ¡· 
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MICROCONTROLADOR MC68HC 11 E9/F 1 

PORTD Datos del puerto D $1008 

Bit 7 Bit 6 Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit O 
PD5 PD4 PD3 PD2 PDl PDO 

PDS PD4 PD3 PD2 PDl PDO 
SS SCK MOSI MISO TxD RxD 

Puerto E 

El puerto E es de 8 bits de entrada general, no le afecta el modo de operación, comparte su función 
con el convertidor analógico digital. 

PORTE Datos del Puerto E $100A 

Bit 7 Bit 6 Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit O 
PE7 PE6 PES PE4 PE3 PE2 PE! PEO 

AN7 AN6 ANS AN4 AN3 AN2 ANl ANO 

Puerto F 

En el modo de operación bootstrap los ocho bits trabajarán únicamente como salida, en modo 
expandido fonnará la parte baja del bus de direcciones (ADR15:8). 

PO RTF Datos del Puerto F $1005 

Bit7 Bit 6 Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit O 
PF7 PF6 PF5 PF4 PF3 PF2 PFl PFO 

ADR15 ADR14 ADR13 ADR12 ADRll ADR!O ADR9 ADR8 

Puerto G 

En single chip y bootstrap, el puerto C se puede configurar para que trabajen sus pincs como salida 
o entrada, dependiendo de la selección realizada en el registro DDRG. En el modo expandido y test, 
los pines (7 :4) pueden ser usados para la función de chip select. 

DDRG Registro de Dirección de Datos del Puerto G $1003 

Bit 7 Bit 6 Bit 5 Bit 4 
DDG7 DDG6 DDGS DDG4 

DDG(7:0) Dirección de datos para el puerto G 

O = Bit seleccionado como entrada 
1 =Bit seleccionado como salida 

Bit 3 Bit 2 Bit 1 Bit O 
DDG3 DDG2 DDGl DDGO 
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APENDICED LM18293/L293 

APENDICED 
LM18293/L293 MANEJADOR DE POTENCIA 

Descripción general 

El LM18293 es un circuito integrado diseñado para manejar motores hasta de 1 A. Entre las 
aplicaciones típicas, incluye manejo de cargas inductivas como solenoides, relevadores, 
motores de corriente directa y motores de paso, emplea intemamente los transistores de 
potencia y titiliza un buffer para señales de nivel bajo. 

En el circuito de aplicación., se presenta el patigrama de este dispositivo, contiene cuatro 
entradas para ingresar señales de control de Jos motores, acepta niveles estandares de lógica 
TTL y DTL, para realizar su interfaz; dos señales de habilitación para controlar la 
velocidad, que también acepta la misma lógica. Cada habilitador controla dos canales; 
cuando el pin de habilitación está desactivado (cero lógico), las salidas correspondientes se 
encontraran con lógica de tres estados; si el pin no está conectado (flotando), el circuito 
funcionará como si estuviera habilitado. 

Se cuenta con dos pines para proporcionar el voltaje; el pin 8 proporciona la potencia del 
motor y el pin 16 suministra un voltaje independiente del anterior, que polariza los circuitos 
intemos. 

El chip está incluido en un diseño DIP de 16 pines, el dispositivo es capaz de operar con 
voltajes máximos de 36 volts. 

La figura mostrara la forma de conectar dos motores y controlar al mismo tiempo el sentido 
de giro; en este caso podrán girar ambos en sentido horario y antihorario. 

Características 
• Salida por canal de 1 Amper 
• Reemplazo directo por el circuito integrado L293B y L293D 
• Empaquetado DIP de 16 pines 
• Protección térmica contra sobrecargas 
• Cero lógico hasta 1.5 volts 
• Alta irununidad al ruido 

Máximos rangos de voltaje 

*Voltaje para las cargas 
*Voltaje de la fuente lógica 
* Voltaje de entrada 
* Habilitación de voltaje 
* Corriente de salida 

(Vs) 36 volts 
(Vss) 36 volts 
(Vi) 7 volts 
(Ve) 7 volts 
2 amperes 
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APENDICED LM18293/L293 

Características eléctricas 

Vs = 24V, Vss = SV, T=2SoC, L = 0.4V, H = 3.5 V. 

ENABLE 1 16 Vss 

INPUT 1 2 15 INPUT4 

OUTPUT 1 3 14 OUTPUT4 

GND 4 13 GND 
LM18293 

GND 5 12 GND 

OUTPUT2 6 JI OUTPUT3 

INPUT2 7 JO INPUT3 

V MOTOR 8 9 ENABLE2 

Asignación de pines. 

Control de los motores de corriente directa 

Para controlar los motores se utiliza el circuito integrado 12930, que como se describió 
anteriormente, nos presenta la capacidad de controlar los dos motores. 

Como se muestra en la figura D-1, y de acuerdo a las canlcterísticas de este circuito, se 
requieren de cuando menos cuatro señales de control, las cuales serán otorgadas por el 
microcontrolador. Para ·controlar un motor se requiere de una señal que entregará el 
comando de dirección del motor, es decir; hacia donde deseamos que gire (derecha o 
izquierda), y otra señal que nos proporcionará la velocidad de giro del motor. Para el 
control del otro motor, se necesita de la misma cantidad de señales. 

Vel1 
EN1 

V ce 
Vcc f 

IN1 IN4 Dr2 

OUT1 OUT 

GNO L
2930

GND M2 

GNO GNO 

OUT2 OUT 

Dr1 IN2 /N3 

Vss EN2 
Vel2 

Figura D-1. Circuito de control de los motores de CD. 
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• APENDICED LM 18293/L293 

El circuito· de la figura D-2, muestra el agregado de una etapa de acoplamiento y 
aislamiento; entre las señales que provienen del microcontrolador y la etapa de control de 
los motores; para tener este tipo de control se requieren de seis señales, cuatro para la 
dirección y dos para la velocidad de giro de los motores. 

Asi mismo, otra ventaja que presenta este circuito es contar con un pin asignado 
exclusivamente para suministrar el voltaje de polarización de los motores, el cuál puede 
tener un valor entre 0.2 hasta 32 volts, como se indica en la hoja de especificaciones del 
L293D en el apéndice C. 

V ce V ce 

f 

~~ Ve 

1 47K EN1 o V ce 

" IN1 IN4 
V ce 

OUT1 OUT t 
~~ GND L293DGND 

o 47K GND GND 

' OUT2 OUT. 
V ce 

IN2 IN3 

"l f Vss 

GJ;o~¡47K 

•,•., 

Figura D-2. Circuito de control de los motores empleando optoacopladores ... 

Es posible utilizar únicamente cuatro señales para controlar los motores , esto es un pin 
para controlar la dirección del motor, por lo tanto una señal deberá estar en alto y la otra en 
bajo, conectando a la salida un inversor (7404) se obtendrá lo. anterior, la otra señal 
controlara el habilitador y lo mismo sucederá con el otro motor. 
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